
Chapter 1

Understanding InDesign 
Ingredients

In This Chapter
▶ Getting acquainted with the InDesign approach

▶ Figuring out global versus local control

▶ Exploring the document window

▶ Surveying the top tools

▶ Becoming familiar with tools and panels

▶ Discovering what’s in the menus

Starting to use a new software application is not unlike meeting a new 
friend for the first time. You take a long look at the person, maybe ask a 

few questions, and begin the process of becoming acquainted. (If you’re not 
new to InDesign but are new to the CS5 version, it’s like seeing a friend you 
haven’t seen in a while — you observe any changes and catch up on what’s 
happened in the meantime.)

Just as it’s worthwhile to find out the likes and dislikes of a new friend, it’s 
also worth your time to wrap your head around InDesign’s unique style 
and approaches. When you do so, you’ll find it much easier to start using 
InDesign to get work done.

This chapter explains where to look in InDesign for the features and capa-
bilities you need to master. (For a quick look at what’s new to version CS5, 
check out Chapter 26.) I introduce you to the process that InDesign assumes 
you use when laying out documents, describe the unique interface elements 
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10 Part I: Before You Begin 

in the document window, survey the most commonly used tools, and explain 
how InDesign packages much of its functionality through an interface ele-
ment called a panel.

Understanding Global and Local Control
The power of desktop publishing in general, and InDesign in particular, is 
that it lets you automate time-consuming layout and typesetting tasks while 
at the same time letting you customize each step of the process according to 
your needs.

What does that mean in practice? That you can use global controls to estab-
lish general settings for layout elements, and then use local controls to 
modify those elements to meet specific requirements. The key to using global 
and local tools effectively is to know when each is appropriate.

Global tools include

 ✓ General preferences and application preferences (see Chapter 2)

 ✓ Master pages and libraries (see Chapter 5)

 ✓ Character and paragraph styles (see Chapter 13)

 ✓ Table and cell styles (see Chapter 18)

 ✓ Object styles (see Chapter 9)

 ✓ Sections and page numbers (see Chapter 4)

 ✓ Color definitions (see Chapter 6)

 ✓ Hyphenation and justification (see Chapter 14)

Styles and master pages are the two main global settings that you can expect 
to override locally throughout a document. You shouldn’t be surprised to 
make such changes often because although the layout and typographic 
functions that styles and master pages automate are the fundamental com-
ponents of any document’s look, they don’t always work for all the specific 
content within a publication. (If they did, who’d need human designers?!)

Local tools include

 ✓ Frame tools (see Part III, as well as Chapter 16)

 ✓ Character and paragraph tools (see Chapters 14 and 15)

 ✓ Graphics tools (see Part V)
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11 Chapter 1: Understanding InDesign Ingredients

Choosing the right tools for the job
Depending on what you’re trying to do with InDesign at any given moment, 
you may or may not immediately know which tool to use. If, for example, you 
maintain fairly precise layout standards throughout a document, using master 
pages is the way to keep your work in order. Using styles is the best solution if 
you want to apply standard character and paragraph formatting throughout a 
document. When you work with one-of-a-kind documents, on the other hand, 
designing master pages and styles doesn’t make much sense — it’s easier just 
to format elements as you create them.

For example, you can create drop caps (large initial letters set into a para-
graph of type, such as the drop cap that starts each chapter in this book) as 
a character option in the Character panel, or you can create a paragraph style 
(formatting that you can apply to whole paragraphs, ensuring that the same 
formatting is applied each time) that contains the drop-cap settings and then 
apply that style to the paragraph containing the drop cap. Which method 
you choose depends on the complexity of your document and how often you 
need to perform the action. The more often you find yourself taking a set of 
steps, the more often you should use a global tool (like character and para-
graph styles) to accomplish the task.

Fortunately, you don’t need to choose between global and local tools while 
you’re in the middle of designing a document. You can always create styles 
from existing local formatting later. You can also add elements to a master 
page if you start to notice that you need them to appear on every page.

Keep your bearings straight
A powerful but confusing capability in InDesign 
is something called a control point. InDesign 
lets you work with objects from nine different 
reference points — any of the four corners, the 
middle of any of the four sides, or the center — 
such as when positioning the object precisely 
or rotating the object. You choose the active 
reference point, or control point, in the Control 
panel or Transform panel, using the grid of nine 
points arranged in a square.

By default, InDesign uses the central reference 
point as the control point, which is great for 
rotating an object, but can lead to confusion 

when you enter in the X and Y coordinates to 
place it precisely. That’s because most people 
use the upper-left corner of an object when 
specifying its coordinates, not the center of 
the object. Be sure to change the control point 
to the upper-left reference point whenever 
entering X and Y coordinates in the Control or 
Transform panels.

How do you change the control point? That’s 
easy: Just click the desired reference point 
in that preview grid. The control point will be 
black, whereas the other reference points will 
be white.
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12 Part I: Before You Begin 

Specifying measurement values
Another situation in which you can choose between local or global controls 
is specifying measurement values. Regardless of the default measurement unit 
you set (that is, the measurement unit that appears in all dialog boxes and 
panels), you can use any unit when entering measurements in an InDesign 
dialog box. For example, if the default measurement is picas, but you’re new 
to publishing and are more comfortable working in inches, go ahead and 
enter measurements in inches.

InDesign accepts any of the following codes for measurement units. (Chap-
ter 2 explains how to change the default measurements.) Note that the x in 
the following items indicates where you specify the value, such as 2i for 2 
inches. It doesn’t matter whether you put a space between the value and 
the code: Typing 2inch and typing 2 inch are the same as far as InDesign is 
concerned:

 ✓ xi or x inch or x" (for inches)

 ✓ xp (for picas)

 ✓ xpt or 0px (for points)

 ✓ xpx (for pixels)

 ✓ xc (for ciceros, a European newspaper measurement)

 ✓ xag (for agates, an American newspaper measurement)

 ✓ xcm (for centimeters)

 ✓ xmm (for millimeters)

What to do when you make a mistake
InDesign is a very forgiving program. If you 
make a mistake, change your mind, or work 
yourself into a complete mess, you don’t have to 
remain in your predicament or save your work. 
InDesign offers several escape routes. You can

 ✓ Undo your last action by choosing 
Edit➪Undo (Ô+Z or Ctrl+Z). (You can’t 
undo some actions, particularly actions 
such as scrolling that don’t affect any items 
or the underlying document structure.) 
You can undo multiple actions in the 
reverse order in which they were done by 

repeatedly choosing Edit➪Undo (Ô+Z or 
Ctrl+Z); each time you undo, the preceding 
action is undone.

 ✓ Redo an action you’ve undone by choosing 
Edit➪Redo (Shift+Ô+Z or Ctrl+Shift+Z). 
Alternatively, choosing Undo and Redo 
is a handy way of seeing a before/after 
view of a particular change. As with an 
undo action, you can redo multiple undone 
actions in the reverse of the order in which 
they were undone.
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13 Chapter 1: Understanding InDesign Ingredients

 InDesign CS5 adds the capability to specify measurements in pixels, as part of 
its newfound capability to create “Web-intent” documents in addition to the 
traditional “print-intent” ones, as Chapter 3 explains.

 You can enter fractional picas in two ways: in decimal format (as in 8.5p) and 
in picas and points (as in 8p6). Either of these settings results in a measure-
ment of 81⁄2 picas. (A pica contains 12 points.)

Discovering the Document Window
In InDesign, you spend lots of time working in document windows — the 
“containers” for your documents. Each document, regardless of its size, is 
contained within its own document window.

The best way to get familiar with the InDesign document window is by 
opening a blank document. Simply choosing File➪New➪Document (Ô+N or 
Ctrl+N) and clicking OK opens a new document window. Don’t worry about 
the settings for now — just explore.

Figure 1-1 shows all the standard elements of a new document window. I 
won’t bore you by covering interface elements that are standard to all pro-
grams. Instead, the rest of this section focuses on InDesign-specific elements.

Rulers
Document windows display a horizontal ruler across the top and a vertical 
ruler down the left side. As shown in Figure 1-1, the horizontal ruler measures 
from the top-left corner of the page across the entire spread, and the vertical 
ruler measures from the top to the bottom of the current page. These rulers 
are handy for judging the size and placement of objects on a page. Even expe-
rienced designers often use the rulers while they experiment with a design.

Both rulers display increments in picas unless you change the measurement 
system for each ruler in the Units & Increments pane of the Preferences 
dialog box. Choose InDesign➪Preferences➪Units & Increments (Ô+K) or 
Edit➪Preferences➪Units & Increments (Ctrl+K) to open the Preferences 
dialog box. Your choices include inches, picas, points, pixels, decimal inches, 
ciceros, agates, millimeters, and centimeters.
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15 Chapter 1: Understanding InDesign Ingredients

 If you change the ruler measurement system when no documents are open, 
the rulers in all new documents will use the measurement system you 
selected. If a document is open when you make the change, the rulers are 
changed only in that document.

 You can also create your own measurement system by choosing Custom. 
Most people should ignore this option, but sometimes it can make sense, such 
as setting the ruler to match the line spacing, so that you can measure number 
of lines in your ruler.

If your computer has a small monitor and the rulers start to get in your way, 
you can hide them by choosing View➪Hide Rulers (Ô+R or Ctrl+R). Get them 
back by choosing View➪Show Rulers (Ô+R or Ctrl+R).

Zero point
The point where the rulers intersect in the upper-left corner of the page is 
called the zero point. (Some people call it the ruler origin.) The zero point is 
the starting place for all horizontal and vertical measurements.

If you need to place items in relation to another spot on the page (for exam-
ple, from the center of a spread rather than from the left-hand page), you can 
move the zero point by clicking and dragging it to a new location. Notice that 
the X: and Y: values in the Control panel update as you drag the zero point so 
that you can place it precisely.

If you change the zero point, it changes for all pages or spreads in the docu-
ment. You can reset the zero point to the upper-left corner of the left-most 
page by double-clicking the intersection of the rulers in the upper-left corner.

 If you move the zero point, all the objects on the page display new X: and Y: 
values even though they haven’t actually moved. Objects above or to the left 
of the zero point will show negative X: and Y: values, and the X: and Y: values 
of other objects will not relate to their actual position on the page or spread.

You can lock the zero point, making it more difficult to accidentally change 
it. Control+click (Mac) or right-click (Windows) the ruler origin and choose 
Lock Zero Point from the menu that appears. (The Unlock Zero Point com-
mand is right there as well, so you can just as easily unlock it.) Locking the 
zero point is a good idea because it will remind anyone working on your doc-
ument that you prefer that they not fiddle with the zero point.
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Pasteboard
The white area that surrounds the page is called the pasteboard. It’s a work-
space for temporarily storing objects. The pasteboard above and below each 
page or spread is an inch deep. The pasteboard at both left and right of a 
page or spread is just as wide as the page. For example, a spread composed 
of two 8-inch-wide pages has 8 inches of pasteboard to the left and 8 inches 
of pasteboard to the right, plus 1 inch of pasteboard above and 1 inch below.

 You can set your own preferred height and width of the pasteboard. To 
do so, open the Guides & Pasteboard pane of the Preferences dialog box 
and choose a new value for the Horizontal Margins and/or Vertical Margins 
field. (Choose InDesign➪Preferences➪Guides & Pasteboard [Ô+K] or 
Edit➪Preferences➪Guides & Pasteboard [Ctrl+K] to open the Preferences 
dialog box.)

Application frame and bar
With the application frame, Mac users can put all the InDesign elements 
in their own container so that they don’t float freely and other applica-
tions don’t peek through. You show the application frame by choosing 
Window➪Application Frame — doing so makes InDesign for Mac behave 
like InDesign for Windows. (By default, the application frame is turned off in 
InDesign for Mac.)

Conversely, Windows users can choose Window➪Application Frame to hide 
the application frame so that InDesign for Windows looks like InDesign for 
Mac. (By default, the application frame is turned on in InDesign for Windows.)

 The Application Frame menu command is a toggle, hiding the application 
frame if it’s visible and showing it if it’s hidden. You see a check mark next to 
the menu option if the application frame is visible. (InDesign uses the same 
toggling indicator in other menus.)

Above the Control panel is the application bar, which offers easy access to 
other Adobe applications, such as Bridge, and access to controls over vari-
ous view options. It appears by default if the application frame is enabled. 
When the application frame is hidden, you can show or hide the application 
bar by choosing Window➪Application Bar.

The application bar has several handy elements. From left to right:

 ✓ The first element is the set of quick-access buttons to Bridge and other 
Adobe software.

 ✓ The second element is the Zoom Level field and pop-up menu.
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17 Chapter 1: Understanding InDesign Ingredients

 ✓ The third element is the View Options pop-up menu, which lets you 
hide and show frames boundaries, hidden characters, grids, and other 
such visual aids from one handy location. These options previously 
existed but only in a variety of scattered menu options (where they also 
remain).

 ✓ The fourth element, the Screen Mode pop-up menu, duplicates the 
Screen Mode feature at the bottom of the Tools panel (explained later 
in this chapter).

 ✓ The fifth element, the Arrange Documents pop-up menu, gives you fast 
access to InDesign’s controls over how document windows are arranged 
(covered later in this chapter).

 ✓ The sixth element, the Workspaces pop-up menu, gives you quick access 
to the workspaces you’ve defined (as described in the “Working with 
Panels, Docks, and Workspaces” section, later in this chapter).

 ✓ The seventh element is the Adobe Community Search menu, which you 
can use to find help from the Adobe community forums on the Web.

 ✓ At the far right is the new Access CS Live button, which opens up 
Adobe’s extra-cost subscription services such as multiuser screen shar-
ing and multiuser design review in your browser. 

Pages and guides
Pages, which you can see on-screen surrounded by black outlines, reflect the 
page size you set up in the New Document dialog box (File➪New➪Document 
[Ô+N or Ctrl+N]). If in your document window it looks like two or more pages 
are touching, you’re looking at a spread.

InDesign uses nonprinting guides, lines that show you the position of margins 
and that help you position objects on the page. Margins are the spaces at the 
outside of the page, whereas columns are vertical spaces where text is sup-
posed to go by default. Magenta lines across the top and bottom of each page 
show the document’s top and bottom margins. Violet lines show left and 
right columns (for single-page documents) or inside and outside columns (for 
spreads).

You can change the location of margin and column guides by choosing 
Layout➪Margins and Columns. You can create additional guides — such as 
to help you visually align objects — by holding down your mouse button on 
the horizontal or vertical ruler and then dragging a guide into the position 
you want.
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Page controls
If you feel like flipping through pages of the document you’re creating, 
InDesign makes it easy with page-turning buttons and the Page field and 
pop-up menu. Controls for entering prefixes for the page numbers of sec-
tions, and for indicating absolute page numbers in a document that con-
tains multiple sections, are also handy. (An absolute page number indicates 
a page’s position in the document, such as +1 for the first page, +2 for the 
second page, and so on.)

At the bottom left of the document window is a combined Page page-number 
field and pop-up menu encased by two sets of arrows. These arrows are page-
turning buttons that take you to, from left to right, the first page, the preced-
ing page, the next page, and the last page. Just click an arrow to get where 
you want to go.

You can also jump directly to a specific document page or master page in 
several ways:

 ✓ Highlight the current number in the page number field (by selecting it 
with your cursor), enter a new page number or master-page name, and 
press Return or Enter.

 ✓ Use the Go to Page dialog box (Ô+J or Ctrl+J), enter a new page number 
or a master-page name, and press Return or Enter.

 ✓ Choose the desired page from the Page pop-up menu.

 ✓ You can also use the Pages panel to navigate your document, as Chap-
ter 4 explains.

Opening Multiple Document Windows
If you like to work on more than one project at once, you’ve come to the right 
program. InDesign lets you open several documents at once. It also lets you 
open multiple windows simultaneously for individual documents. A large 
monitor (or having multiple monitors connected) makes this multiwindow 
feature even more useful. By opening multiple windows, you can

 ✓ Display two (or more) different pages or spreads at once. You still have 
to work on the documents one at a time, but no navigation is required — 
you have only to click within the appropriate window.

 ✓ Display multiple magnifications of the same page. For example, you 
can work on a detail at high magnification in one window and display the 
entire page — and see the results of your detail work — at actual size in 
another window.
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19 Chapter 1: Understanding InDesign Ingredients

 ✓ Display a master page in one window and a document page based 
on that master page in another window. When you change the master 
page, the change is reflected in the window in which the associated 
document page is displayed.

Document windows are by default accessed through a set of tabs below the 
Control panel, though as I explain later, you can also work with them as a 
series of free-floating windows.

When multiple windows are open, you activate a window by clicking on a 
window’s title tab or anywhere within its window. Also, the names of all open 
documents are displayed at the bottom of the Window menu. Choosing a 
document name from the Window menu brings that document to the front. 
If multiple windows are open for a particular document, each window is 
displayed (they’re displayed in the order in which you created them) in the 
Window menu.

To show multiple windows on-screen at once, first make them free-floating by 
choosing Window➪Float All in Window. Then choose either 

 ✓ Window➪Arrange➪Tile 

  When you choose the Tile command, all open windows are resized and 
displayed side by side. 

 ✓ Window➪Arrange➪Cascade

  When you choose the Cascade command, the windows overlap each 
other so that each title bar is visible. 

You can also use one of the window-layout options in the Arrange Documents 
pop-up menu’s options in the application bar. How they display will depend 
on the option you chose. 

To put all these windows back into their regular tabs so that only one docu-
ment window is visible on-screen at a time, choose Window➪Arrange➪
Consolidate All Windows or choose the Consolidate All Windows option (the 
single-window icon) in the Arrange Documents pop-up menu in the applica-
tion bar.

 To close all windows for the currently displayed document, press Shift+Ô+W 
or Ctrl+Shift+W. To close all windows for all open documents, press 
Option+Shift+Ô+W or Ctrl+Alt+Shift+W.

Not only do you get separate document windows for each open docu-
ment, but you can also create multiple windows for an individual docu-
ment so that you can see different parts of it at the same time. To open 
a new window for the active document, choose Window➪Arrange➪New 
Window (or use the New Window option in the new Arrange Documents 
pop-up menu in the application bar). The new window is displayed in its 
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own tab or free-floating window, depending on whether you’ve enabled 
Open Documents as Tabs in the Interface pane of the Preferences dialog box 
(InDesign➪Preferences➪Interface [Ô+K] or Edit➪Preferences➪Interface 
[Ctrl+K]).

 You can tell that a document window shows a different view of an existing 
document by looking at the name of the document in the window’s title. 
At the end of the document name will be a colon (:) followed by a number. 
Newsletter.indd:1 would be the document’s first window, Newsletter.indd:2 
would be its second window, and so on.

Tooling around the Tools Panel
You can move the InDesign Tools panel (see Figure 1-2) — the control center 
for 32 of InDesign’s 33 tools, as well as for 13 additional functions — by click-
ing and dragging it into position. The Tools panel usually appears to the left 
of a document.

 The one tool not directly accessible from the Tools panel is the Marker tool. 
But you can switch to it from the Eyedropper tool by holding Option or Alt. 
(Chapter 6 explains its use.)

 To discover each tool’s “official” name, hover the mouse pointer over a 
tool for a few seconds, and a tool tip will appear (see Figure 1-2), telling 
you the name of that tool. If the tool tips don’t display, make sure that the 
Tool Tips pop-up menu is set to Normal or Fast in the Interface pane of the 
Preferences dialog box (choose InDesign➪Preferences➪Interface [Ô+K] or 
Edit➪Preferences➪Interface [Ctrl+K]).

Tools panel includes tools for creating and manipulating the objects that 
make up your designs. The tools in the Tools panel are similar to those in 
other Adobe products (such as Photoshop, Illustrator, and Dreamweaver). 

You don’t need to worry about all the tools, so in the text that follows I high-
light just those that you’ll need to know to start using InDesign. You’ll likely 
come across the other tools as you work on specific tasks, so I cover those 
tools in the chapters that introduce those functions.

The small arrow in the lower-right corner of some tools is a pop-out menu 
indicator. A tool that displays this arrow is hiding one or more similar tools. 
To access these “hidden” tools, click and hold a tool that has the pop-out 
menu indicator, as shown in Figure 1-2. You can also Control+click or right-
click a tool to see the “hidden” tools. When the pop-out displays, click one of 
the new tools.
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 InDesign adds two tools: the Page tool (see Chapter 4) and the Gap tool (see 
Chapter 10). It drops the Position tool. Also, you can get more detail on any 
tool and how to use it by going to the new Tool Hints panel (choose Window➪
Utilities➪Tool Hints); it shows options for whatever tool you then select.

 

Figure 1-2: 
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Using the Selection tools
To work with objects, you have to select them. InDesign provides two tools 
to do that, letting you select different aspects of objects.

Selection tool
The Selection tool is perhaps the most-used tool in InDesign. With the 
Selection tool, you can select objects on the page and move or resize them. 
You may want to think of this tool as the Mover tool because it’s the only tool 
that lets you drag objects around on-screen.

After you’ve selected the Selection tool, here’s how it works:

 ✓ To select any object on a document page, click it. If you can’t seem to 
select it, the object might be placed by a master page (a preformatted 
page used to format pages automatically), or the object might be behind 
another object.

 ✓ To select an object placed by a master page, press Shift+Ô or Ctrl+Shift 
while you click.

 ✓ To select an object that is completely behind another object, Ô+click 
it or Ctrl+click it. For graphics frames, you can also click the “doughnut 
hole” icon — formally called the content grabber — that appears over the 
center of an object when you hover over any portion of it.

 The content grabber is new to InDesign CS5. You can turn it off and on by 
choosing View➪Extras➪Show/Hide Content Grabber.

Direct Selection tool
The Direct Selection tool is what you use to work on the contents of a frame, 
not the frame itself. For example, you can use the Direct Selection tool to 
select individual handles on objects to reshape them or to move graphics 
within their frames.

Here’s how the Direct Selection tool works:

 ✓ To select an object to reshape it, click the object to display anchor 
points on the edges (the anchor points are hollow handles that you can 
select individually, as shown in Figure 1-3). You can drag the anchor 
points to reshape the object.

 ✓ To select objects placed by a master page, Shift+Ô+click or 
Ctrl+Shift+click, as with the Selection tool. The Direct Selection tool lets 
you easily select objects behind other objects and select items within 
groups.

 ✓ To move a graphic within its frame, click inside the frame and drag the 
graphic. The new content grabber is also available when using the Direct 
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Selection tool, making it easier to select and move graphics in frames 
that are overlapped by others.

 ✓ To move a frame but leave the graphic in place, click an edge of the 
frame and drag it.

Using the Type tool
A very frequently used tool, the Type tool lets you enter, edit, and format 
text. The Type tool also lets you create rectangular text frames.

Here’s how the Type tool works:

 ✓ To create a rectangular text frame, click and drag; hold the Shift key to 
create a perfect square.

 ✓ To begin typing or editing text, click in a text frame or in any empty 
frame and type away.

I explain stories and threaded text frames in Chapter 11.

 

Figure 1-3: 
Reshaping 

an item with 
the Direct 
Selection 

tool.
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Using the object-creation tools
InDesign has a bunch of tools for creating shapes. Part V covers them in 
more depth, but you should know about a few of them now because they 
create objects that can contain either text or graphics. Plus, you can also use 
them to draw your own shapes that you then color or otherwise embellish in 
your layout. Here’s what you need to know:

 ✓ Pen tool: With the Pen tool, you can create simple illustrations. You 
use the Pen tool, which is modeled after the pen tools in Illustrator and 
Photoshop, to create paths (both open, such as lines, and closed, such 
as shapes) consisting of straight and curved segments. Give it a try — 
it’s fun! (Chapter 7 explains how to use the tool.)

 ✓ Type tool: The Type tool lets you draw rectangular text frames, as well 
as type text inside them.

 ✓ Line tool: The Line tool lets you draw freestanding lines (paths) on your 
page. After selecting this tool, simply click and drag the mouse to draw 
the line. Holding the Shift key while you click and drag constrains the 
line angle to 45-degree increments, which is useful for creating straight 
horizontal and vertical lines.

 ✓ Frame and shape tools: InDesign has three frame tools (Rectangle Frame, 
Ellipse Frame, and Polygon Frame) and three shape tools (Rectangle, 
Ellipse, and Polygon). The frame and shape tools are redundant because 
both frames and shapes can hold text or graphics or be empty.

  Because the frame and shape tools really do the same thing, you might 
use the frame tool when creating frames that will have their content 
added later. Why? Because the frames appear with a big X through them, 
making them easier to spot when looking for frames to fill. The shape 
tools create frames without that X, so it’s easier to overlook them.

  To create a rectangle or ellipse, choose the appropriate tool, click some-
where in the document window, and drag the mouse to another loca-
tion. The rectangle or ellipse fills the area. But creating a polygon works 
differently, as Chapter 7 explains.

Using the navigation tools
Several tools, described in the following list, help you navigate your docu-
ment so that you can move around your pages, move your pages around the 
screen, and change the degree of magnification to see just part of a page or to 
see several pages at once.
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 ✓ Hand tool: The Hand tool lets you move a page around to view differ-
ent portions of it or another page entirely. After selecting the Hand tool, 
click and drag in any direction. You can access the Hand tool temporar-
ily without actually switching tools by pressing Option+spacebar or 
Alt+spacebar.

  For a quick way to pan through your document, make sure that the Hand 
tool is active. Then click and hold the mouse. InDesign will zoom out and 
display a red rectangle. If you move the mouse, InDesign stops zooming 
and instead lets you move the rectangle to a new area of focus. Let go 
to have InDesign display that part of the document back at the original 
zoom setting. If the autozoom is too fast, you can use the up and down 
arrow keys instead to manually move through various zoom levels. And 
if you decide you’ve navigated some place you didn’t mean to, just press 
Esc — as long as the mouse is still pressed — to start over.

 ✓ Zoom tool: With the Zoom tool, you increase and decrease the document 
view scale. You can highlight a specific area on a page to change its view, 
or you can click on-screen to change the view scale within InDesign’s 
preset increments, which is the same as pressing Ô+= or Ctrl+= to zoom in.

 ✓ Screen Mode buttons: At the very bottom of the Tools panel is the 
Screen Mode button, which by default shows the Normal mode as active. 
Its pop-out menu has four additional options: Bleed, Slug, Preview, and 
Presentation. The Normal screen mode shows rulers, frame edges, 
document margins, page boundaries, guides, text flow indicators, and 
all the other visual cues that InDesign displays to help you identify 
various kinds of objects. The Preview mode shows you just the pages 
and their content, without these onscreen indicators, so you can see 
what the reader will ultimately see, The Bleed mode is a variation of the 
Preview mode that shows any objects that bleed (extend) beyond the 
page boundaries, whereas Slug mode is a variation of the Preview mode 
that shows the space reserved for information such as crop marks and 
color separation names used in final output. (The View menu also has a 
Screen Mode submenu that lets you access these modes.)

  The new Presentation mode is also a variation of the Preview mode, 
except that even the InDesign menus and document window disap-
pear, so all you see is the layout. Furthermore, you can go through the 
layout as if it were a slideshow, such as to show the layout comps to a 
client. Click the mouse or press → to advance to the next spread, and 
Shift+click or right-click the mouse or press ← to go to the previous 
spread. You can also press Home to go to the first spread and End to go 
to the final spread. Press Esc to return to your previous screen mode.

  If your Tools panel displays in two columns, you get two screen mode 
buttons at the bottom of the panel: Normal and Preview. In that case, 
Preview Mode has a pop-out menu that also has the Presentation, Bleed, 
and Slug options. To toggle between single-column and two-column 
views of the Tools panel, click the collapse icon (>> or <<, depending on 
how many columns are displayed) at the top of the panel.
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Working with Panels, Docks, 
and Workspaces

InDesign has so many controls and features that its designers have long ago 
stopped relying on menu commands to access them all. Instead, most of 
InDesign’s features are presented as sort of miniature dialog boxes, called 
panels, that are “windows” of readily accessible options to consider when 
working in InDesign.

Working with panels
Panels provide an interactive method of working with features, one that lets 
you access the controls quickly. In many cases, panels offer the only method 
for performing many tasks. Figure 1-1, earlier in this chapter, shows the panels 
that appear on-screen by default. Note that you can access all panels — except 
Quick Apply and Tabs — via the Window menu, whether or not the panel is 
displayed on-screen at the moment.

Panels typically have three — but sometimes four — controls:

 ✓ All panels but the Access CS Live, Attributes, Background Tasks, CS 
News and Resources, Kuler, Pathfinder, Script Label, Story, Tool Hints, 
and Tools panels have a flyout menu, which provides a pop-up menu of 
controls relevant to that panel.

 ✓ Any active panel — meaning it’s displayed in front of any others in its 
panel group so that you can actually modify its settings — has a close 
control to remove the panel from the panel group. This control isn’t a 
way to switch to another panel in that panel group — to do that, just 
click the tab of the panel you want to work with. (If you remove a panel 
by mistake, go to the Window menu to open it again.)

Using contextual menus
InDesign’s contextual menu interface element 
is very useful. By Control+clicking or right-
clicking the document, an object, elements 
listed in a panel (such as a list of files or styles), 
the rulers, and so on, you can display a menu of 

options for modifying whatever it is you clicked. 
InDesign provides a lot of options this way, and 
using the contextual menus to access InDesign 
functions is often easier than hunting through 
the many regular menu options and panels.
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 ✓ Any active panel has a collapse control (the >> icon). For panels in the 
dock, clicking that icon collapses it back into the dock. For panels not in 
the dock (that is, for floating panels), collapsing them shrinks the panel 
to a much smaller size to get them out of the way. When collapsed, these 
panels will have a << icon to expand them again. (The Tools panel is an 
exception: Clicking the >> icon changes it to a two-column layout, while 
clicking the << icon changes it to a one-column layout.)

 ✓ Some panels have an expand/collapse control, which looks like a caret 
(^) above a down-facing caret. Click the control to show more or fewer 
options. (If all options are displayed, clicking the control will shorten the 
panel and hide some of the advanced options; if only the basic options 
are displayed, clicking the control lengthens the panel and shows all the 
options.)

 Panels new to InDesign CS5 are 

 ✓ The Access CS Live, CS News and Resources, and CS Review panels 
(which relate to extra-cost online services from Adobe not covered in 
this book)

 ✓ The Animation, Background Tasks, Media, Object States, Preview, and 
Timing panels, which are part of InDesign CS5’s new multimedia capa-
bilities (see Chapter 24)

 ✓ The Mini Bridge and Tool Hints panels covered in this chapter

 ✓ The Track Changes panels (see Chapter 12)

To better suit your working style, you can drag panels by their tabs to move 
them from one panel group to another, drag them out of a dock so that 
they’re free-floating, or drag them into a dock so that they’re no longer free-
floating. The dock feature lets you keep panel groups in one contained area, 
which helps keep the interface from getting too cluttered. But you’re not 
forced to work this way: You can still drag panels outside the main dock so 
that they’re free-floating on-screen.

Not all panels display in the main dock; less-used panels, such as Data Merge, 
show up in a free-floating panel group when you open them via the Window 
menu. Of course, you can always add such panels to the main dock if you use 
them a lot.

 All but three panels have a tab, which contains its name, to help you select 
the desired panel without having to go to the Window menu. The three special 
panels (without tabs) are the Tools, Control, and Quick Apply panels. Unlike 
the rest of InDesign’s panels, they can’t be grouped with other panels, so you 
don’t need a tab to select them. Also, note that the Quick Apply panel is the 
only one not available via the Window menu; instead, use the lightning-bolt 
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icon to open it from the Control panel and several other panels; you can also 
choose Edit➪Quick Apply (Ô+Return or Ctrl+Enter).

To quickly select a panel, just click its tab from its open panel group. When a 
panel is active, its controls have the following characteristics:

 ✓ To display and select an option, click a pop-up menu or an iconic 
button; the changes take effect immediately.

 ✓ To place a new value in a field, highlight the value that’s already in 
the field and enter the new value. Note that fields accept values in all 
supported measurement systems, as described in the “Specifying mea-
surement values” section, earlier in this chapter. To implement the new 
value, press Shift+Return or Shift+Enter. To get out of a field you’ve 
modified, leaving the object unchanged, press Esc.

 ✓ To increase or decrease the value in the field, use the clickable up and 
down arrows where available.

 ✓ To use math to perform changes, enter calculations in the field. You can 
add, subtract, multiply, and divide values in fields by using the follow-
ing operators: +, –, * (multiply), and / (divide). For example, to reduce 
the width of a frame by half, type /2 after the current value in the Width 
field. Or, to increase the length of a line by 6 points, you can type +6 
next to the current value in the Length field. You can also use percent-
ages in fields, such as 50%, which adjusts the current value by that 
percentage.

As with the tools, if you make sure that Tool Tips is set to Normal or Fast 
in the Interface pane of the Preferences dialog box (choose InDesign➪
Preferences➪Interface [Ô+K] or Edit➪Preferences➪Interface [Ctrl+K]), you’ll 
get some ideas as to what the panel iconic buttons and fields do.

 If panels are getting in your way, you can make them all disappear by press-
ing Tab — as long as the Type tool is not active and the text cursor is active 
within a text frame, of course. Press Tab to get your panels back.

Working with docks
Docks have controls to collapse and expand them. Click the double-arrow 
iconic button at a dock’s upper corner to collapse or expand the dock. You 
can also resize the main dock by dragging its resize handle. Figure 1-4 shows 
the dock controls and what they look like when expanded and collapsed.
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Figure 1-4: 
The 

collapsed 
dock is the 

default (left), 
but you can 

expand it 
(right).

 

Working with workspaces
Although you can rearrange InDesign’s panels to suit your needs, rearranging 
again and again as you switch from one task to another can be a real chore. 
For example, you may open several of the table- and text-oriented panels 
when working on text, but then close them and open the graphics- and 
positioning-oriented panels when refining layout placement.

That’s why InDesign lets you create workspaces, which are essentially 
memorized panel collections. Display the panels you want, where you want 
them, and create a new workspace by choosing Window➪Workspace➪New 
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Workspace. (Note that this menu option has been called Save Workspace in 
previous versions.) Give the workspace a name that makes sense, such as 
Text Panels. That workspace is now available via Window➪Workspace➪
workspace name, automatically displaying just those saved panels in their 
saved locations.

Not only can you save workspaces, but you can also tell InDesign to save any 
menu customizations made along with the currently opened selection panels 
into that workspace. (Chapter 2 covers menu customization.)

Working with the Mini Bridge
Adobe’s Bridge application lets you manage project files across the Adobe 
Creative Suite, as well as get preview information on files and their attributes 
(such as color depth for image files). 

 Bridge is mostly used by Photoshop users, but you might find it useful for 
perusing project files or searching for files based on metadata attributes such 
as color model. 

The new Mini Bridge panel in InDesign CS5 lets you use Bridge’s file naviga-
tion and information capabilities without leaving InDesign. 

To navigate to files on your computer from Mini Bridge, start by turning on 
the Panel Bar view; click the Panel View icon (it looks like a page) and select 
Panel Bar. Now you can navigate your files in Mini Bridge. You can also drag 
files right into InDesign from Mini Bridge. 

Surveying the Menus
Although InDesign relies heavily on its panels to present its rich capabilities, 
it also uses traditional menus. In some cases, you can use menus instead of 
panels; in others, you must use a menu command; in still others, you must 
use a panel (such as for the data merge and object alignment features).

InDesign for Windows has nine menus, while InDesign for Macintosh has ten:

 ✓ InDesign (Macintosh only): This menu contains the Preferences menu, 
where you set much of InDesign’s behavioral defaults. You can also con-
figure plug-ins (now called extensions) here. Other functions are stan-
dard for all Mac programs, including hiding and quitting the program. 
Note that none of these menu items’ functions are available in panels.

 ✓ File: This menu is where you open, create, save, close, export, and set 
up documents and books; where you import text and graphics; where 
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you print documents and prepare them for commercial printing; and 
where you set basic user information. Note that none of these menu 
items’ functions are available in panels, except for the Preflight feature.

 ✓ Edit: This menu lets you cut, copy, and paste elements; edit, spell-check, 
and do search-and-replace operations across entire stories and set up 
story for the InCopy add-on program; adjust and manage color settings; 
set up and change keyboard shortcuts and menu preferences; apply 
various styles to selected objects and text; and undo and redo recent 
actions. In Windows, you also set preferences and quit the program 
from this menu. Note that these menu items’ functions, except for Quick 
Apply, aren’t available in panels.

 ✓ Layout: With this menu, you add, delete, rearrange, and navigate pages; 
change margins and guides; automatically resize a page and its objects; 
set up page numbering and sections; and create and format tables of 
contents. Note that these menu options’ functions — except for the 
Pages, page-navigation, and Numbering & Section Options menus — 
aren’t available in panels.

 ✓ Type: With this menu, you adjust typographic attributes such as size 
and font, insert special characters, work with footnotes, work with 
layout notes; add placeholder text; and control the on-screen display of 
special characters such as spaces. Note that the Find Font, Change Case, 
Type on a Path, Document Footnote Options, Text Variables, Insert 
Character, Fill with Placeholder Text, Tabs, and Show Hidden Characters 
menu items’ functions aren’t available through panels.

 ✓ Object: You use this menu to change the shape, size, location, and other 
attributes of objects, such as frames and lines; apply special effects to 
objects; insert multimedia effects such as buttons; and control how fast 
the screen redraws when you make changes. Note that the Text Frame 
Options, Anchored Object, Corner Options, Clipping Path, and Convert 
Shape menu items’ functions aren’t available through panels.

 ✓ Table: Use this menu to create, change, and format tables and cells. 
Note that this menu’s functions are available through panels.

 ✓ View: This menu lets you control the display of your document, from 
zoom level to whether guides, rulers, and frame edges appear. Note that 
none of these menu items’ functions, except for Screen Mode and the 
zoom controls, are available in panels.

 ✓ Window: This menu is where you manage the display of document 
windows and panels, as well as where you set up and work with work-
spaces. The window display and workspace functions aren’t available 
via panels.

 ✓ Help: Use this menu to access InDesign’s help system and manage 
product activation and registration. In Windows, this menu also lets 
you manage plug-ins. Note that none of these menu items’ functions are 
available in panels.
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